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16 Spreadsheet Applications

16.1  IntroductIon

General purpose spreadsheet software can be used effectively for engineering 
 calculations. For example, Microsoft Excel with Visual Basic for Applications is 
an effective tool for process design. Spreadsheets offer sufficient process model 
“hospitality.” They are connected easily and online with charts and graphic objects, 
resulting in powerful and easy-to-use graphical interfaces. Excel also supports 
mathematical and statistical tools. For instance, Solver is an excellent tool for 
solving sets of equations and performing optimization. Databases are effectively 
and easily accessed. In addition, Visual Basic for Applications offers a powerful 
object-oriented programming language capable of constructing commercial graph-
ics interfaces.

Our book Food Process Design (Maroulis and Saravacos, 2003) presents a sys-
tematic approach to solve engineering problems in a spreadsheet environment. In 
particular, it shows integrated procedures for robust process design by analyzing the 
following topics:

• Modeling and spreadsheets
• Analyzing the Solver
• Sensitivity analysis using Excel tables
• Controls and Dialog boxes to input data
• Graphics to get results
• Databases
• Visual Basic as a programming language

In the present book, a more simplified concept is adopted. It is a step from classic 
hand calculations toward more sophisticated spreadsheet calculations.

The following topics are introduced and applied to problems similar to those of 
the previous chapters of this book.

• Name variables
• Insert data
• Insert equations using names
• Use “Goal Seek” to solve an equation
• Automate using Visual Basic
• Assign a macro to a button
• Use Excel tables
• Use Excel charts
• Use the scroll bars
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• Construct a simple database
• Use Combo Boxes
• Use matrix operations
• Use Solver

16.2  Shell and tubeS heat exchanger

In this example, the following Excel operations are introduced:

• Name variables (Ctrl + Shift + F3)
• Insert data
• Insert equations using names

16.2.1  Problem Formulation

Calculate the appropriate shell and tube heat exchanger for a tomato paste heating 
process using the available heating steam.

The design specifications are

F = 1 kg/s Feed flow rate

T1 = 50°C Feed temperature

T2 = 100°C Target temperature

Ts = 120°C Steam temperature

The required data of the tomato paste and the heating steam are

ρ = 1130 kg/m3 Fluid density

λ = 0.55 W/(m K) Fluid thermal conductivity

η = 0.27 Pa s Fluid apparent viscosity

Cp = 3.50 kJ/(kg K) Specific heat

ΔHs = 2200 kJ/kg Latent heat of steam condensation

The following design variables are also assumed:

u = 1 m/s Fluid velocity in tubes

d = 0.01 m Tube diameter

dx = 5 mm Tube thickness

n = 4 Number of passes in tubes

16.2.2  Problem Solution

The thermal load is calculated by the equation

 
Q FC T Tp= −( )2 1
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The required steam flow rate Q is calculated by the equation

 Q F Hs s= ∆

The mean temperature difference ΔTm

 

∆T T T T T

T T T T
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s s

s s

= − − −
− −[ ]

( ) ( )
ln ( ) / ( )

1 2

1 2

The total number of tubes N

 
u

F

N n d
=

ρ π( )( )2 4

The surface heat transfer coefficient outside tubes ho

 
h

Nd

F
o

s

= 





2750
1 3/

The Pr number

 
Pr

Cp=
η

λ

The Re number

 
Re

d u= ρ
η

The Nu number

 
Nu

d

L
= 











1 86
1 3

.
/

RePr
w

η
η

0.14

The surface heat transfer coefficient inside tubes hi

 
Nu

h di=
λ

The overall heat transfer coefficient U

 

1 1 1
U h hi o

= +

83538_C016.indd   525 12/1/2010   1:05:07 AM



526 Food Process Engineering Operations

A
B

C
D

E
F

1
Va

ri
ab

le
Te

xt
 N

am
e

Ex
ce

l N
am

e
Va

lu
e

U
ni

ts
Eq

ua
ti

on
2

Fe
ed

 fl
ow

 ra
te

F
F

1
kg

/s
3

Fe
ed

 te
m

pe
ra

tu
re

T 1
T

1.
50

°C
4

Ta
rg

et
 te

m
pe

ra
tu

re
T 2

T
2.

10
0

°C
5

St
ea

m
 te

m
pe

ra
tu

re
T s

Ts
12

0
°C

6
Fl

ui
d 

sp
ec

ifi
c 

he
at

C
p

C
p

3.
50

kJ
/k

gC
7

La
te

nt
 h

ea
t o

f s
te

am
 c

on
de

ns
at

io
n

Δ
H

s
dH

s
22

00
kJ

/k
g

8
Fl

ui
d 

de
ns

ity
ρ

p_
11

30
K

g/
m

3

9
Fl

ui
d 

th
er

m
al

 c
on

du
ct

iv
ity

λ
k_

0.
55

W
/m

K
10

Fl
ui

d 
ap

pa
re

nt
 v

is
co

sit
y

η
n_

0.
27

Pa
 s

11
Fl

ui
d 

ve
lo

ci
ty

 in
 tu

be
s

u
u.

1.
00

m
/s

12
Tu

be
 d

ia
m

et
er

d
d

0.
01

m
13

Tu
be

 th
ic

kn
es

s
δx

dx
5

m
m

14
N

um
be

r o
f p

as
se

s i
n 

tu
be

s
n

m
4

—
16

Th
er

m
al

 lo
ad

Q
Q

17
5

kW
:=

F*
C

p*
(T

2.
−T

1.
)

17
St

ea
m

 fl
ow

 ra
te

F s
Fs

0.
08

kg
/s

:=
Q

/d
H

s
18

M
ea

n 
te

m
pe

ra
tu

re
 d

iff
er

en
ce

Δ
T

m
dT

m
40

°C
:=

( (
Ts

−T
1.

)−
(T

s−
T

2.
) )

/L
N

( (
Ts

−T
1.

)/
(T

s−
T

2.
) )

19
To

ta
l n

um
be

r o
f t

ub
es

N
M

.
45

—
:=

F/
p_

/(
u.

/m
)/

(3
.1

4*
dˆ

2/
4)

20
Su

rf
ac

e 
he

at
 tr

an
sf

er
 c

oe
ffi

ci
en

t o
ut

sid
e 

tu
be

s
h o

ho
4.

90
kW

/m
2 K

:=
2.

75
*(

M
.*d

/F
s)

ˆ(
1/

3)

21
Pr

 N
um

be
r

Pr
Pr

17
18

—
:=

C
p*

n_
/k

_*
10

00
22

Re
 N

um
be

r
Re

Re
42

—
:=

u.
*p

_*
d/

n_
23

N
u 

N
um

be
r

N
u

N
u

9.
28

—
:=

1.
86

*(
Re

*P
r*

d/
10

)ˆ
(1

/3
)*

1.
2

24
Su

rf
ac

e 
he

at
 tr

an
sf

er
 c

oe
ffi

ci
en

t i
ns

id
e 

tu
be

s
h i

hi
0.

51
kW

/m
2 K

:=
N

u*
k_

/d
/1

00
0

25
O

ve
ra

ll 
he

at
 tr

an
sf

er
 c

oe
ffi

ci
en

t
U

U
0.

46
kW

/m
2 K

:=
(1

/(
1/

ho
+1

/h
i) 

)
27

H
ea

t t
ra

ns
fe

r a
re

a
A

A
9.

48
m

2
:=

Q
/U

/d
Tm

28
Sh

el
l d

ia
m

et
er

D
D

.
0.

20
m

:=
(d

+2
*d

x/
10

00
)* (M

./0
.3

19
)ˆ

(1
/2

.1
42

)
29

Tu
be

 le
ng

th
L

L
6.

70
m

:=
A

/M
./3

.1
4/

d

FI
g

u
r

e 
16

.1

83538_C016.indd   526 12/1/2010   1:05:07 AM



Spreadsheet Applications 527

The total heat transfer area A

 Q AU Tm= ∆

The shell diameter D

 
N

D

d
= 



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0 319
2 142

.
.

The tubes length L

 A N dL= π

16.2.3  excel imPlementation

In an Excel spreadsheet and in the range A2:A29, type the names of the process 
variables incorporated in the previous solution as shown in Figure 16.1. The range 
A2:A14 is used for the data while the range A16:A29 for the results. In the next 
column and in the range B2:B29, type the symbols for these variables as used in the 
solution provided earlier.

In the range C2:C29, type the corresponding names in Excel. Use names simi-
lar to their symbols in the text if possible. In the range E2:E29, type the corre-
sponding units.

By selecting the range C2:D29 and by simultaneously pressing the buttons Ctrl + 
Shift + F3, the names in column C are assigned to the cells of column D (Figure 16.2).

Enter the data for the given variables in the range D2:D14. Enter the equations 
according to the previous solution procedure into the range D16:D29. These equa-
tions are presented for information in the range F16:F29.

The problem has been solved. Any change of the data will change the result. The 
problem is solved with just 13 equations in the range D16:D29 by using 13 data in 
the range D2:D14. All other text in the spreadsheet is for information (Figure 16.1).

FIgure 16.2
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16.3  PSychrometrIc calculatIonS

In this example, the following simple Excel calculations are introduced:

• Use the Goal Seek function to solve an equation
• Automate Using Simple Visual Basic
• Assign a macro to a button

16.3.1  Problem Formulation

For an air/water mixture, when the following conditions are given:

P = 1 bar Pressure

T = 65°C Temperature

Y = 0.035 kg/kg db Total humidity (liquid + vapor)

Calculate the following properties:

Pd bar Dew pressure

Ps bar Vapor pressure at temperature T

Pw bar Vapor pressure at temperature Tw

Tb °C Boiling temperature

Td °C Dew temperature

Tw °C Wet bulb temperature

YL kg/kg db Humidity in liquid

YV kg/kg db Humidity in vapor

Ys kg/kg db Saturation humidity at temperature T

Yw kg/kg db Saturation humidity at temperature Tw

aw — Water activity

H kJ/kg db Enthalpy of humid air

CP kJ/kg K db Specific heat of humid air

ΔHS kJ/kg  Latent heat of condensation of water 
vapor at temperature T

Suppose that the following data are valid:

m = 0.622 Air/water molecular weight ratio

CPA = 1.00 kJ/kg K Specific heat of air

CPV = 1.90 kJ/kg K Specific heat of water vapor

CPW = 4.20 kJ/kg K Specific heat of liquid water

ΔH0 = 2.50 MJ/kg Latent heat of water evaporation at 0°C

a1 = 1.19 × 101 Antoine equation constants for water

a2 = 3.99 × 103

a3 = 2.34 × 102
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16.3.2  Problem Solution

A simple psychrometric model has been presented by Maroulis and Saravacos 
(2003) as follows:

PS = exp [a1 – a2/(a3 + T)] (E01)

YS = m PS/(P – PS) (E02)

YV = min (Y, YS) (E03)

YL = Y – YV (E04)

YV = mawPS/(P − awPS) (E05)

H = CPAT + YV (ΔH0 + CPV T) + YLCPLT (E06)

Tb = − a3 + a2/(a1 − ln P) (E07)

Td = a2/(a1 – ln[Y P/(m + Y)]) – a3 (E08)

Pd = exp[a1 – a2/(a3 + T)] (E09)

Pw = exp[a1 – a2/(a3 + Tw)] (E10)

Yw = mPw/(P – Pw) (E11)

CP = CPA + YV CPV (E12)

ΔHS = ΔH0 – (CPL – CPV)T (E13)

(YV – YW)/(T – TW) = – CP/ΔHS (E14)

Based on these equations, the following algorithm can be used:

(E01) → Ps

(E02) → Ys

(E03) → YV

(E04) → YL

(E05) → aw

(E06) → H

(E07) → Tb

(E08) → Td

(E09) → Pd

Tw Trial value ←
(E10) → Pw

(E11) → Yw

(E12) → CP

(E13) → ΔHS

(E14) → Tw Corrected value →

16.3.3  excel imPlementation

Using the same conventions as in the previous example, the following spreadsheet is 
constructed (Figure 16.3):

As the algorithm suggests, wet bulb temperature is calculated by trial and error, 
which means that we assign a trial value to cell D23 and examine the resulting cell 
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D29. We try different values in cell D23 until we obtain the same value in cell D29. 
The difference between the trial and corrected values is calculated in cell D30.

Alternatively, we can use the “Goal Seek” function of Excel to automatically set 
cell D30 to equal 0 by changing cell D23. Goal Seek can be found in the “Data” 
menu by selecting the “What-if Analysis” submenu (Figure 16.4).

Furthermore, we can automate the procedure as follows:

• From the “Developer” menu and the “Insert” submenu select a Button 
(Form Control) and insert it into the spreadsheet.

• By right clicking on the button, select “Edit text” and insert a caption e.g., 
wbt (Wet Bulb Temperature).

• By right clicking on the button, select “Assign Macro” (Figure 16.5) and 
then “Edit.”

• Type the following subroutine within the Visual Basic Editor.
 1. Sub wbd()
 2. Range(“Tw”).Value = Range(“Td”).Value
 3. Range(“wbt”).GoalSeek Goal: = 0#, ChangingCell:=Range(“Tw”)
 4. End Sub

The calculations are automatically happened every time the button “wbt” is 
clicking.

16.4  PSychrometrIc chart

In this example, the following Excel functions are introduced:

• Use a 2D Excel table
• Use an Excel chart

FIgure 16.4
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16.4.1  Problem Formulation

Construct a psychrometric chart, i.e., plot the humidity in vapor YV (kg/kg db) versus 
the temperature T (°C) for some constant values of water activity aw (–) for an air 
water-vapor mixture at any pressure P (bar).

Suppose the following parameters are given:

m = 0.622 Water molecular weight ratio

a1 = 1.19 × 101 Antoine equation constants for water

a2 = 3.99 × 103

a3 = 2.34 × 102

16.4.2  Problem SolutIon

The humidity is calculated from the equation

 
Y

ma P

P a P
V

w S

w S

=
−( )

where the vapor pressure is calculated by the Antoine equation

 
P

a a

a T
S = −

+






exp 1 2

3( )

Thus, for any given values of P, T, and aw, the YV is obtained.

16.4.3  excel imPlementation

The solution just presented is provided in the following spreadsheet (Figure 16.6):

FIgure 16.5
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A 2D Excel table is used to calculate the humidity for various values of temperature 
and water activity as follows (Figure 16.7):

 1. In the range R4:R99, type the desired values for temperature and in the 
range S3:W3, the desired values for water activity.

 2. In cell R3 insert the equation “=Yv.”
 3. Select the range R3:W25, and from the menu “Data” and submenu 

“What-if Analysis” select “Data Table.” The Data Table dialogue will 
appear (Figure 16.8).

 4. In Data Table Dialogue assign cell “T” for the Row Input Cell and cell “aw” 
for the Column Input Cell. The corresponding values for humidity are auto-
matically filled in the range S4:W25 (Figure 16.7).

Select the range R3:W25 shown in Figure 16.7 and from the menu “Insert” select 
the “Scatter”  diagram. The psychrometric chart in Figure 16.7 is constructed.

16.5  calculatIonS on PSychrometrIc chart

In this example, the following Excel function is introduced:

• Use the scroll bar to change the values of a variable

16.5.1  Problem Formulation

In the psychometric chart of Example 3, select a point of given temperature and 
humidity (T, Y) and construct the corresponding dew point (Td, Y), the saturated 
point (T, Ys), and the wet bulb point (Tw, Yw).

I J K L M N
1

Variable
Text 

Symbol
Excel 
Name Value Units Equation

2 Antoine equation 
constant for water a1

a1 a1. 1.19E+01 —

3 Antoine equation 
constant for water a2

a2 a2. 3.99E+03 —

4 Antoine equation 
constant for water a3

a3 a3. 2.34E+02 —

5 Air/water molecular 
weight ratio

m m 0.622 —

6 Water activity aw aw. 1.00 —
7 Pressure P P. 1.00 bar
8 Temperature T T. 65.00 °C
9 Vapor pressure at 

temperature
Ps Ps. 0.249 bar :=EXP(a1.−a2./(a3.+T.) )

10 Humidity in vapor YV Yv. 0.206 kg/kg db :=m*aw.*Ps./(P.−aw.*Ps.)

FIgure 16.6
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P Q R S T U V W

Yv(T, aw)
0.206 0.20 0.40 0.60 0.80 1.00

0 0.001 0.002 0.002 0.003 0.004
5 0.001 0.002 0.003 0.004 0.006

10 0.002 0.003 0.005 0.006 0.008
15 0.002 0.004 0.006 0.009 0.011
20 0.003 0.006 0.009 0.012 0.015
25 0.004 0.008 0.012 0.016 0.020
30 0.005 0.011 0.016 0.022 0.028
35 0.007 0.014 0.022 0.029 0.037
40 0.009 0.019 0.029 0.039 0.050
45 0.012 0.025 0.038 0.052 0.066
50 0.016 0.032 0.050 0.068 0.087
55 0.020 0.042 0.065 0.089 0.116
60 0.026 0.054 0.084 0.117 0.154
65 0.033 0.069 0.109 0.155 0.206
70 0.041 0.088 0.142 0.205 0.279
75 0.052 0.112 0.185 0.275 0.386
80 0.065 0.144 0.244 0.375 0.552
85 0.081 0.185 0.326 0.527 0.836
90 0.100 0.240 0.445 0.779 1.418
95 0.125 0.314 0.629 1.265 3.215
99 0.150 0.394 0.864 2.145 19.447
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Spreadsheet Applications 535

16.5.2  Problem Solution

When P, T, and Y are given, all the corresponding psychrometric properties are cal-
culated according to Example 2.

Thus, if we combine Examples 2 and 3 in one spreadsheet, the problem is solved 
by plotting the results of Example 2 in the chart of Example 3.

16.5.3  excel imPlementation

In the range AC27:AD33, insert the equations presented in the range AH29:AI31. In 
the psychrometric chart insert two more curves, AC27:AD31 and AC32:AD33, and 
the icon appears in Figure 16.9.

If the values of cells T and Y change, the above points are moved in the chart 
and the new conditions appear. Obviously, the button “wbt” described in Example 2 
should be pressed (Figure 16.3).

More automation can be applied by using “scroll bars”:
From the “Developer” menu and the submenu “Insert” insert a “Scroll Bar.” By 

right clicking on the Scroll Bar select “Format Control” and select the temperature 
cell T (F11) for the “Cell Link” (Figure 16.10).

In order to automatically calculate the wet bulb temperature (without clicking the 
“wbt” button) right click the scroll bar and select “Assign Macro.” Assign the macro 
“wbt” to the scroll bar.

The Scroll Bar is now able to automatically change the temperature and move the 
point (T, Y) left or right. All other points (Td, Y), (T, Ys), and (Tw, Yw) are automatically 
redrawn.

Scroll bar can also be inserted for pressure and/or humidity.

16.6  ISothermS

In this example, the following Excel functions are introduced:

• Construct a simple properties database
• Use a Combo Box to present data from a database

FIgure 16.8
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536 Food Process Engineering Operations

16.6.1  Problem Formulation

The equilibrium material moisture content Xe depends on air temperature, T and 
water activity, aw.

Various empirical or semitheoretical models have been proposed in the literature, 
but a modified Oswin model seems to be the most appropriate in process design 
calculations:
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where b1, b2, and b3 are adjustable empirical constants, depending on the material 
characteristics.

The purpose of this example is to construct a database in an Excel environment to 
incorporate the Oswin constants for some materials and by using the various Excel 

AA AB AC AD AE AF AG AH AI AJ AK AL AM

65 0.206 (T, Ys) : =T : =Ys
65 0.035 (T, Y) : =T : =Y
34 0.035 (Td, Y) : =Td : =Y
65 0.035 (T, Y) : =T : =Y
39 0.047 (Tw, Yw) : =Tw : =Yw
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Spreadsheet Applications 537

utilities to construct an environment in which the moisture isotherms for various 
materials will be examined automatically.

16.6.2  excel imPlementation

Retrieve some values for the Oswin constants from the literature (e.g., Maroulis and 
Saravacos 2003) and insert these values in to an Excel spreadsheet as shown in the 
range B2:E6 in Figure 16.11.

Insert initial data values for the variables as follows:

jMaterial Material identification number

T Temperature

Aw Water activity

Insert the following equations for the following corresponding variable:

Name :=INDEX(Material,jMaterial)

b1. :=INDEX(Oswin1,jMaterial)

b2. :=INDEX(Oswin2,jMaterial)

b3. :=INDEX(Oswin3,jMaterial)

Xe :=b1.*EXP(b2./(273 + T))*(aw/(1-aw))∧b3.

The INDEX function selects a specific value from an array.

FIgure 16.10
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538 Food Process Engineering Operations

The following Excel names should be assigned in the following cells:

name cell
aw C15

b1. C11

b2. C12

b3. C13

jMaterial C8

Material B3:B6

Oswin1 C3:C6

Oswin2 D3:D6

Oswin3 E3:E6

T C14

Xe C16
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2 Material Oswin1 Oswin2 Oswin3
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Spreadsheet Applications 539

Insert a 2D Excel table using water activity values as the Column Input Cell and 
Temperature values as the Row Input Cell. The resulting table is shown in Figure 16.11.

Insert a Scatter Graph, as also shown in Figure 16.11, to graphically represent the 
results of the 2D Excel table.

Automate the material selection using a “Combo Box”:

• Insert a “Combo Box” from the menu “Developer” and submenu “Insert.”
• Right click on the Combo Box and select “Format Control.”
• In the “Format Control Dialogue,” assign the “Material” name to the “Input 

Range” and the “jMaterial” name to the “Cell Link” (Figure 16.12).

The spreadsheet is now fully automated:
By clicking the Combo Box, the available material appears in the Combo Box 

List, and when a material is selected from the list, the material isotherms are auto-
matically plotted in the Chart (Figure 16.11).

16.7  FIttIng rheologIcal data For chocolate

In this example, the following Excel functions are introduced:

• Use matrix operations (Alt + Ctrl + Shift + ok)
• Excel Solver

FIgure 16.12
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16.7.1  Problem Formulation

Analyze the rheological data on chocolate at 40°C, obtained in the COST 90 
European project (Prentice and Huber 1983), using the Casson model:

 τ τ γ= +( )/ /
o
1 2 1 2 2 Kc

where
τ (Pa) is the shear stress
γ (1/s) is the shear rate
τo and Kc are the Gasson constants

1
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5 g Texp Tcal sd 1446
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16.7.2  excel imPlementation

In the spreadsheet in the Figure 16.13, 423 experimental data from 17 different labo-
ratories are introduced in the range C6:D428.

Initial values for the Gasson constants are also introduced in the range H2:H3.
In the range E6:E428, the calculated values using the Gasson model are intro-

duced using the equation:= (To∧0.5 + Kc*g∧0.5)∧2 in each cell.

The following Excel names should be assigned in the following cells:

name cell
g C6:C428

Kc H3

sd H5

Tcal E6:E428

Texp D6:D428

To H2

The standard deviation between the experimental and calculated values is estimated 
in cell H5 by using the equation:

:={SQRT(SUM( (Texp-Tcal)∧2))}

Since Texp and Tcal are arrays, the mathematical operation in the cell refers to the 
matrix operation.

This is denoted by pressing Alt + Ctrl + Shift simultaneously when ok is clicked 
to end the equation editing. If the brackets {} exist in the equation, the matrix opera-
tion has been accepted.

A comparison between the experimental and calculated values can be obtained 
by introducing the appropriate chart.

Curve fitting means finding the best values for the parameters To and Kc to mini-
mize the standard deviation sd between the experimental and calculated values.

FIgure 16.14
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542 Food Process Engineering Operations

This operation can be performed using the Excel Solver:

• From the menu “Data” select “solver” and the Solver Parameters Dialogue 
will appear (Figure 16.14).

• Select the “min” operation, insert the variable “sd” in the “Set Target 
Cell” parameter, and the variables “To; Kc” in the “By Changing Cells” 
parameter.

• By pressing the button “Solve”, the optimization procedure is executed, and 
after some iteration, the optimal parameter estimates are obtained.
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